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How To Use This Guide
Welcome to the new mixing console that you already own. The d8b Version 3.0 (V3) upgrade offers a host 
of new features that can make your mixes sound better and speed your workflow. This guide is designed 
to introduce current Version 2 d8b users to the new features in V3 and get you working with them 
quickly. We’ll work our way through the channel strip, take a tour of the new automation functions and 
features, and finally, address new file and session management features.  

We’re assuming that you’re already familiar with the basic operation of the d8b, so we won’t start at the 
beginning, but will just describe what’s different. The most effective way to use this guide is to try the 
new features while sitting at your console, so load up the new software, pull up a chair and your favorite 
beverage, and let’s get on with the tour.  But first . . . 

When Not to Upgrade (just yet)
We know you’ll love your updated console, but there are some things that are sufficiently different that 
may affect projects you have in progress. The Automation Event List has been replaced by a new Event 
Track, so existing dynamically automated snapshots may not be recalled completely unless a few tricks 
are performed (refer to the section on Automation). The compressor and gate dynamics curves have 
been changed substantially. While your existing dynamics settings will still be recalled, they’ll sound 
different with the new curves. Finally, surround panning (LCRS and 7.1 implementation) has changed 
significantly. If you’re in the midst of a mix that depends heavily on these functions, you might want to 
finish it up using your current version before upgrading your console to save some fix-up time.

You may choose to upgrade now anyway, and while it’s possible to simply reinstall OS versions using a 
couple of floppies, the audio and operational differences would dictate that you should complete your 
v2 mixes using v2.  V3 mixes will not be read by V2. If you are planning on or have purchased a UFX 
card, V2 will not support it.

Channel Strip Routing
Many of the new features and functions are found along the channel strip. Many new routing possibili-
ties allow you to utilize more DSP functions, both internal and plug-in, than before. In addition, V3 
provides some shortcuts that will make common routing setups easier. A quick glance at the V3 updated 
block diagram will give you the picture.

Routing an Input to Tape
There are a few new related features here.  First, you can assign a single channel to multiple direct 
outputs.  This is useful when you want to record repeated passes of a performance on multiple tape 
tracks.  Assign the input channel to the tracks you want to use, then use the recorder’s track arming 
controls to select on which track you’re actually recording.  From the console surface, this operation is 
similar to V2 only now you can press the ASSIGN buttons for multiple outputs. 

e.g. To assign Channel 1 to Direct Outputs 1-5:

• In the Assignment section on the console surface, press ROUTE TO TAPE

• Press Channel 1’s SELECT button

• Press Channel 1-5’s ASSIGN buttons

From the GUI:

• Click and hold the Out(put) button of Channel 1.  
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• Select each of the Tape Outputs 1 through 5. they will be checked off as you route themand the 
display will show the highest valued tape output. 

Or, if you’d like to set all of the current outputs to source one channel:

• Click on the option Set Channel to All. 

Feedback Alert!  This assignment trick works on tape return channels as well as on  mic/line input 
channels. You can therefore assign a channel output to a tape track that’s returning to that channel. 
Tracks that are in Input Monitor can feed back.

A related feature is the assignment of channels to their corresponding direct outputs.  A new GUI 
shortcut is the Bank to Outputs menu selection, which can be selected from any channel’s Output 
button. This assigns Channel 1 to Direct Output 1, Channel 2 to Direct Output 2 and so on. It’s convenient 
for live recording where you have one microphone per track. There’s the same potential for feedback 
here as suggested above, so if you’re assigning tape return channels to direct outputs, do so with care. 
Note that this feature operates on the current selected bank, and would normally be selected from 
fader bank 1 (ch1-24).

The output assignment menu contains two new Reset features:

Reset All clears all the direct output assignments on all channels.

Reset Channel Only clears any direct output assignments on the channel from which the menu has 
been accessed.

Neither of these Reset functions affects the subgroup or L/R assignments, only the direct outputs.

FADERS TO TAPE

A new feature related to the Direct Output assignment is the Faders To Tape Option, which allows for 
traditional analog console-style Direct Out level following the source channel’s fader level. This differs 
from V2, where the direct out level was fixed as pre-Fader. 

This Feature is enabled using the Options menu and selecting Faders To Tape. This will affect the direct 
out on any source channel on any bank.  This isn’t a routing function, it’s a control-linking function. The 
signal still gets to tape in the same way, it’s just controlled by an alternate knob. You’ll discover that with 
this mode engaged, turning the V-Pot corresponding to a channel fader which is now assigned to control 
tape level will cause the fader to move. 

Note that switching Faders To Tape on and off resets the direct outputs to their former levels before 
switching. This could be unity gain if you’ve made no tape level adjustments prior to assigning Faders 
To Tape. Don’t be caught unaware! 

It’s rare that you’d need to switch between modes during a studio tracking session – you’re likely to 
develop a preference for which controls you use to set record levels. In a session where you’re combining 
live PA with recording, however, the Faders To Tape option is handy for establishing initial recording 
levels while you’re setting up the PA mix. This will assure that something will be recorded during the 
sound check even if you’re not paying full attention to the recording levels just yet. 

If you’re doing this, save a snapshot of the channels (which saves the direct output levels) after you have 
the level settings in the ballpark. Then switch Faders To Tape off  during the break between the sound 
check and the show, and recall the snapshot to re-establish the direct output levels to your initial “PA” 
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settings. You’ll start off with a known setting for record levels, you’ll re-establish independent control 
of the tape and PA mix levels, and can trim tape levels at any time by assigning the V-pots to LEVEL 
TO TAPE.

Pre-DSP Channel Insert and Patching
Insert points on channels now allow the outputs from up to 16 plug-ins, the 12 Auxiliary sends, 8 busses, 
outputs from channels 1-48, the 16 FX sends, 8 returns from the Alt I/O, and stereo 2 track digital inputs 
to be routed to the pre-dynamics and EQ input of any channel. In addition to putting a plug-in in line 
with a channel conveniently, this allows such flexibility as assigning several channels to a bus, then 
processing them as a group through a single channel. Think of this as the patchbay you’ve always 
wanted. 

Clicking on the PRE insert button on any channel brings up a menu which offers a selection of plug-ins, 
plus the new Channel Patch option.  Opening the Channel Patch menu lists all the choices available 
for pre-DSP sources. The stereo digital source is displayed as either S/PDIF or AES/EBU, following the 
selection in the Setup Digital I/O menu. 

The insert functions like a return on a half-normalled patchbay point. Patching a channel output into a 
pre-DSP channel input breaks the connection to the original source for that channel. Patching a plug-in 
at that point is a true in-line insert. The plug-in’s input is fed from the channel input, and the plug-in’s 
output feeds the rest of the channel.

When a channel has pre-DSP input is assigned, the block at the top of the GUI channel strip indicates the 
patched-in source. If a plug-in is patched in, clicking on the plug-in name in this block will open the GUI 
module for the plug-in if it’s been put out of view.

The Reset selection from the Pre- or Post-Insert pulldown menu clears the insert assignment.

This feature can be used as a “mult”, that is, a single channel’s output (post DSP / post post insert / pre-
fader) can be routed to several channels for different processing. You can also use this capability to send 
the output of a bus (or pair) to the main L/R outputs by assigning the bus output to a channel insert, 
then assigning that channel to the L/R outputs, allowing for a traditional ‘subgrouping’ capability. A 
bus/channel pair assigned in this manner should be panned appropriately in the associated channels.

While channel patches can be accessed only from the console GUI screen, plug-in patches can be 
assigned from the console work surface. See the Plug-Ins section for details.

Note once again that the channel output available for patching is post-everything but the fader, so EQ 
and dynamics processing on the source channel will be carried along to the destination channel.

Post-DSP Insert
Post-DSP inserts work just as the Pre-DSP inserts with the exception that only plug-ins are available. 
There is no Channel Patch submenu. Post-DSP inserts can also be selected from the Fat Channel screen.

Master Insert
Plug-ins can also be inserted in the left and right channels of the Master. Clicking on the Left or Right 
insert button at the top of the Master channel strip will bring up the Plug-in insert menu. 

It can also be accessed from the Fat Channel screen by selecting either the Pre- or Post-DSP button, 
though channel patching is not available to the Master.

The Master insert points are Post master fader. For dynamic module related activities, this may diminish 
the usability for fades on the Master Output. A workaround is to de-assign all of the original destination 
channels intended for the L/R bus, and re-assign them to a bus pair. Route the bus pair through two 
spare channels and assign the Post Insert on the channels to the dynamics plugin module, then assign 
the channel pair to the L/R mains.
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General Insert Tips
The MFX plug-ins and cards were originally designed for Send/Return usage and do not contain a 
Wet/Dry mix control. Inserting them in line on a channel path may not accomplish the desired audio 
results. We recommend using them in the conventional  send/return setup.

The mono delay and TC Level 1 reverb UFX plug-ins also do not allow for wet/dry mix operation. Same 
recommendation as above - go for the send and return type of application. 

The TC Level 1 reverb is mono In to stereo Out, hence splitting it between two channel inserts will not 
allow for the possible intended desired results of stereo separation. Again, go for the send and return 
type of application. 

Note: The 2 track stereo digital AES/EBU and S/PDIF inputs are currently fixed at a 20-bit word length. 
The original intention for these digital inputs was as playback monitor returns for DAT, CD, and other 
16-bit sources. Allowing these stereo inputs to be patched into a channel is convenient for many 
applications. If you need full 24-bit resolution on a stereo input, use one of the I/O card slots and the 
appropriate connections. 

Fader Cross-Patching
In V2, the fader functions are fixed by bank (1-24 for mic/line inputs, 25-48 for tape returns, etc.). In V3, 
the assignments can be modified. This allows you to re-arrange the control surface to bring a frequently-
used fader from a hidden bank into your active mixing bank. For example, you might want to keep the 
tape returns (Bank 2) open for mixing, but also want to be able to manipulate an effect return without 
switching banks. Using the cross-patching feature, you can send a tape return that you don’t need to 
change during the mix off to a fader in another bank and replace its fader’s function with an effect 
return that you want to ride during the mix. This doesn’t re-route signals, it simply ties the control to 
a different handle.

Clicking on the channel number box brings up a list of possible faders which can be assigned to that 
channel. The currently assigned fader is indicated by a dot. Click on the one you want to assign it to that 
channel. The background color of the channel number box changes to dark gray to indicate that it’s been 
re-assigned, and the current fader number appears in the box.  

The channel number box displays the “native” channel all alone in the right column so it’s handy when 
you want to put things back where they belong.

You can also access this feature from the console surface and VFD. From the SETUP section, press the 
GENERAL button, then select Layout from the VFD. Channels are displayed in groups of four, with the top 
row being the native channel number and the bottom row the reassignment for that channel. Select the 
desired reassignment with either the Select button or V-Pot.

Note that assigning a fader to a new channel does not automatically un-assign it from its original 
position, so if you have a lot of things going on in your mix, you may need to “clear the decks” on another 
bank to make room for a fader that you need occasionally. You may not have to do this, though, since 
re-assigning a channel’s fader doesn’t change the signal. If you set the level from tape track 24 on its 
normally assigned fader (48), then assign an effect return to that fader, the tape return level stays where 
you left it, and will follow automation if there are moves on the tape return channel.

Channel Linking between an adjacent Cross patched channel and a pre-existing channel is not possible. 
Linking is only possible on adjacent channels, as in V2. A cross patched channel may still be placed over 
or adjacent to linked channel pairs.

Note: Meters do not follow cross patching - the metering reflects the bank channels as in previous OS 
versions. The console hardware architecture does not allow for this, hence be aware of this fact!
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Pre and Post Auxiliary Sends
As in V2, the auxiliary sends can be globally assigned pre- or post-fader (though always post EQ and 
dynamics) from the Setup Mix Options menu. In V3, each auxiliary send in each channel can be individu-
ally assigned pre- or post-fader. 

Sends can be switched either from the main mixer screen or the Fat Channel screen. 

To toggle between pre-and post-fader send in the mixer screen, hold the Alt key and click on the send 
level indicator bar for the channel and send you wish to change. A pre-fader send is indicated by a yellow 
bar, a red bar indicates a post-fader send. 

With the Fat Channel displayed on screen, click on the small rectangular window below the auxiliary 
send knob to toggle that send pre- or post-fader. A pre-fader send is indicated by a yellow indication (lit) 
below the knob, while a post-fader send has a black indication (unlit appearance). 

Dynamics Processing
V3 includes several changes to the compressor and gate. The big news is that the attack and release 
curves have been modified, giving a much smoother sound.

Compressor
The compressor release curve has been changed from a logarithmic taper in V2 to a linear taper in V3. 
Maximum release time is 2500 msec (2.5 seconds). 

A Soft Knee switch has been added to ease the onset of compression. The Soft Knee button appears on 
the Fat Channel screen. It can also be toggled from the control surface when the Compressor is selected 
in the VFD. The Soft Knee control (as well as output level) is accessed by pressing the Page Right button 
at the right side of the VFD.

Dynamics Key Input
A keying input has been added to the dynamics section. This allows the gain to be controlled by an 
external input rather than by the channel input to the gate or compressor. The key input can come 
from Channels 1-48, the busses, effects sends or returns, or the stereo digital inputs. The default is the 
channel itself.

Clicking on the Key Input box of the Fat Channel screen and selecting Dynamics Key brings up a list 
of available sources. Be aware that the key source is derived after any pre- or post-DSP inserts, channel 
dynamics, and EQ, so all of those processes on the key source channel will affect the dynamics keying. 

Typical applications for this feature:

Use a keyed gate to synchronize the signal on one channel to that of another. For example, keying the 
bass channel from the kick drum channel will keep the bass player and drummer in step. 

Make a stereo compressor by keying both compressors from the same channel. If both compressors 
are set identically (you can do that using Copy and Paste from their pull-down Menu buttons) using 
the same signal to key both channels will assure that the gain reduction is identical on each channel, 
keeping the stereo image from shifting. You may wish to route the channel signals to a bus, sum them, 
then use the sum, rather than a single channel, for the key input.  

Note that the Key Input affects both the compressor and the gate. If you want to compress a channel 
normally but also gate it with a keyed gate, route one channel into another, engaging only the compres-
sor in one channel and only the gate on in the other channel.
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Dynamics EQ Sidechain Input
V3 allows an equalizer to be patched into the dynamics section to make a frequency selective compres-
sor or gate. As with the key input, the EQ affects both the compressor and the gate. Typical applications 
are de-ess by increasing the compressor sensitivity in the sibilant frequency range, or to make a 
frequency-selective gate.

The dynamics sidechain equalizer is “borrowed” from high band of the channel equalizer section, 
so the channel equalization becomes three-band when using the dynamics EQ. The 20/20 equalizer 
type gives the most flexibility in the sidechain application, both for the original channel and the 
key input EQ.

In the Fat Channel screen, the Dynamics EQ control section consists of a small EQ frequency response 
display, a MODE button, and an ON button. MODE toggles the high frequency band of the equalizer 
section between the sidechain and the normal channel path. The ON button toggles the application of 
the sidechain EQ so you can compare the effect with and without. 

Like the standard channel EQ display, the EQ curve for the dynamics can be dragged into shape with 
the mouse cursor, sliding it horizontally to change the frequency, vertically to change the amplitude, 
and right-clicking and dragging sideways (or left-clicking with the Alt key depressed) to change the Q. 
Dynamics EQ can also be selected from the control surface by selecting EQ, then SETUP in the fat channel 
section. The BAND 4 ->DYN button is the equivalent of the MODE button, toggling EQ Band 4 between 
the channel path and the dynamics section. The EQ DYN button toggles the application of the sidechain 
EQ for comparison. 

Note that the main EQ button must be ON in order for the dynamics EQ to operate.

Surround Panning
First, a couple of changes: Assignments in the LCRS 
and 7.1 surround modes have been corrected to agree 
with industry convention. In V2, S was sub, but is now 
Surround. In 7.1 mode, 7 & 8 are now inside (left and 
right center) rather than outside (left and right side).
Two new controls have been added to the surround pan-
ning display. 

The Low Frequency Effect control is an independent send 
level, rather than the deriving the low frequency channel 
by summing the surround channels. In the V3 surround 
panning window, you can now adjust the low frequency 
level independent of the other outputs.

Depth of Center (DOC) adjusts the relative level between 
the front center and the front left and right speakers for 
sources panned toward the center. With DOC set to zero, a 

source that is panned dead center is routed to the center channel only and drops entirely from the left 
and right channels. As the DOC control is raised, the level of the center channel drops and the level of the 
left and right channels increase until at maximum DOC, there’s no center, and the center is “phantom” 
from the left and right channels.

The MORPH function, which automatically moves a source between two preset pan positions, has been 
visually refined so that the pan position dot changes color at the end of the transition. Also new is that 
the Low Frequency Effect setting is included in the MORPH, ideal for that jet plane flyover. DOC is also 
included in the Morph function, cool for the big vocal spread, on cue...
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Channel List
The Channel List has been reworked in V3. MIDI controller assignments are no longer part of the Channel 
List, as they are now assignable via the MIDI Map window. There’s a new Channel Delay, and a switch to 
disable the noise filter on analog inputs.

Channel Delay
All digital processors and A/D/A converters have a small but finite amount of throughput delay. While 
all the basic channels of the d8b have identical delay (sometimes called “latency”), adding a plug-in to 
a channel, cascading channels (or consoles), or sending a signal out to an analog processor and back 
into the mix by this circuitous route can cause that channel’s signal to be a bit late relative to the 
other tracks. V3 now has the capability to add a small amount of delay in the channel path so that 

you can equalize the throughput 
time between channels with dif-
fering signal paths. 

While you can enter a delay value 
(up to 255 samples) directly into 
the channel list, most often what 
you really want to do is find the 
“slowest” channel, leave that one 
alone, and delay all the other 
channels to match it. The d8b has 
a quicker way to do this than to 
type in a number 47 times. Here’s 
how:

• Select the “slow” channel 
using the SELECT button on the 
console work surface or clicking 
on the SELECT button on the GUI 
screen.

• Open the Channel pull-down 
menu and select Adjust Channel 
Delay. Note that the dialog box 
states that non-selected channels 
will be delayed. 

• Type the number of samples 
you think you need for the delay 
(you’ll have to experiment unless 
you have the capability to make 
an actual measurement) into the 
dialog box, and click on Enter.

Now, when you open the Channel List and look at the Delay column, you’ll see that the selected channel 
will be OFF (unless it’s been offset by another delay setting), and all the other channels will contain the 
same delay that you entered in the delay dialog box. It may be a good idea to leave the channel list open 
while you experiment to see how these adjustments modify the channels in the channel list.

While you can’t delay a channel by a negative amount, once a delay has been set, you can enter a 
negative number in the dialog box to reduce the amount of delay. The negative delay will be subtracted 
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from all the unselected channels.

Delays added to the unselected channels are cumulative. If you’ve compensated for a 50 sample delay in 
Channel 10 and now want to compensate for a 20 sample delay in Channel 11, select Channel 11 and enter 
20 samples in the dialog box. This will change Channel 10’s delay from OFF to 20 samples, and change all 
the other channel delays from 50 to 70 samples. 

Reset Channel Delay in the Channel menu resets the delayed channels, however it currently isn’t 
the simplest way to clear delays. Like the Adjust Channel Delay function, it operates on selected 
channels, but in the Reset case, you need to deselect the undelayed channel and select all the other 
channels(since those are the ones with the delay). 

An easier way to bring the channels back to normal is to select the undelayed channel, select Adjust 
Channel Delay from the Channel menu, and enter a negative value equal to the delay on all the other 
channels. 

Analog Noise Filter
The d8b incorporates a frequency-dependent filter designed to eliminate random, low level noise from 
the analog-to-digital converters. At very low signal levels, it’s possible for this filter to trigger intermit-
tently, causing annoying changes in the noise floor on open analog inputs. The Filter column in the 
Channel List allows you to disable this filter on channels where noise is a problem. 

To toggle the filter off or on, open the Channel List and click on the Filter setting. While filters are shown 
for Channels 1-48, they are not active on channels equipped with digital I/O cards. 

Ungrouping

When channels are removed from a group, V3 provides a new option for the daughter channel to either 
retain or lose mute and fader static (current value without automation) or dynamic automation values 
which it acquired from the group master while part of a group. 

There are 4 cases where removing a daughter channel from a group may affect its retained mute or 
fader values. When neither the master nor daughter have automation, one or the other has automation, 
or both have automation. The Master fader level or mute value will be superimposed (modified or 
multiplied, however you want to consider it) on the daughter channel when the channel is released 
from the group.

To remove a channel from a group, SELECT it, then select Ungroup from the Channel menu. A “Retain 
All Levels” check box now appears in the Ungroup dialog box. With the box checked, all static levels or 
automation moves written to that channel or the Master while under group control will be ‘retained’ or 
modified by the Group master’s mute status or moves. A group Master mute will override any daughter 
mutes. The Group master’s automation levels will basically be used as a trim offset function against the 
entire daughter’s automation track, if one exists.

The best way to understand all of this is to perform moves on both a daughter and a group master, 
examine them in the Mix Editor, and then Ungroup using the Retain All Levels function. Then try it with 
a mixture of automation vs. static settings. Then static vs. static. 

Typical applications for this may include a quick level trim on a group of channels in real time, without 
using the Mix Editor. Or just freeing up channels for other Groups if you’re maxed out on all of the 
virtual groups.
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Plug-in Architecture
The plug-in assignment window has been revamped in V3. In addition, new buttons at the bottom of the 
GUI display allow for quick access to loaded plug-ins, as well as quick access to the plug-in assignment 
window.

First, the new buttons. The button at the bottom of the screen that looks like a plug toggles the rest 
of the buttons from their normal functions to quick-access plug-in buttons. When this plug-in view is 
selected, loaded plug-ins appear as buttons. Clicking on any plug-in button brings its GUI up on the 
screen.

The Plug-ins button at the bottom of the screen opens the Plug-in assignment window.

An important change from the control surface vantage is that V-Strip assignment of plug-ins using the 
Aux 1 through Aux 8 buttons no longer applies. All assignment is performed using the Plug Ins button 
in the Assignment section and the Plug-ins button in the VFD section. This operational approach is a 
byproduct of the new Insert function.

Naturally Plug-in settings can be automated either with snapshots or dynamically. See the Automation 
section for details.

Installing Plug-ins 
The d8b is supplied with one MFX card that supports the Mackie MFX 3.0 stereo multi-effects processor 
and IVL Vocal Studio. The new UFX card supports third party plug-ins. Third-party plug-in software is 
licensed, and the software must first be loaded, then unlocked in order to be used. Instructions for 
loading and unlocking plug-ins are provided with both the UFX card and the plug-in package so they 
won’t be repeated here. Demo versions of all of the current UFX plug-ins are provided with the UFX 
card. Those will operate just like the licensed version, but will periodically become unassigned to their 
slot until unlocked.

Loading MFX cards is similar to v2 using the Setup Plugin button to load the MFX card to the MFX 
or Vocal Studio algorithm. After the effect is loaded, the various MFX types (reverb, delay, chorus) are 
accessible from the console surface via the VFD Plug-ins switch and subsequent VFD soft buttons. Note 
that the default Aux send routings are not editable from the console surface - use the GUI instead. 

Once a plug-in is loaded, preset patches are available from the VFD section Load Patch buttons (tip: use 
the VFD page buttons to access factory vs. user presets)

Plug-in Assignments
As before, plug-ins must be downloaded from disk to memory before they can be used. They can be 
loaded from the console surface as before, using the PLUG-INS button in the Setup section. A new 
Plug-In Configuration screen is available from the Plug-ins menu for loading and assigning plug-ins
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Here’s a description of what you’ll find in the GUI Plug-In Assignment Window

SLOT: There are sixteen possible input slots for plug-
ins, distributed among four physical card slots. MFX 
cards permit two inputs, UFX cards permit four, so 
unless all four card slots are filled with UFX cards, not 
all 16 input slots will be available.

A number in the Slot column with a blue background 
indicates that no plug-in is loaded in that slot.  A 
bronze background indicates that there’s a plug-in 
loaded in that slot, but not displayed on the screen.  
A yellow background indicates a plug-in loaded and 
displayed. You can display a “hidden” plug-in either by 
selecting its name from the pulldown Plug-Ins menu 
or from the quick access buttons if the plug-in view 
display is active.

INPUT: The Input column is a popdown menu dis-
playing the possible sources for the plug-in’s input. 
Defaults are auxiliary sends, but any place where a 
plug-in can be inserted can be accessed from this 

menu. Submenus pop up for Pre- and Post-DSP channel inserts as well as other Aux sends and the main 
left and right inserts. The same input lists are available when clicking on the Pre- or Post-DSP insert 
points on the channel or pulling down the Input menu on the individual plug-in GUI. These are just 
some alternate routes to accomplish the same input assignment.

PLUGIN: The Plug-in column displays the plug-ins available for that slot if none are loaded, or the 
currently loaded plug-in. To load a plug-in, pull down this menu and select it from the list. UFX plug-ins 
are designated as licensed or not by a lock icon. Locked plug-ins can be loaded, but will only operate 
in the demo mode.

MODE: This selects whether the slot is configured for mono, dual mono or stereo effects. This will depend 
on the plug-in that’s loaded. 

Tip: Another way to approach this Plug-in configuration window is to think Right to Left, column wise. 
Especially when you use UFX cards, you’ll first determine whether you want to allocate a mono or stereo 
configuration, then call up the Plug-in module for the application, then assign the (Input) routing, and 
finally call up the GUI window to display the parameters.

VFD and Console Surface Plug-in Operation
Plug-ins can be assigned to Pre- and Post-DSP channel inserts by holding the Channel SELECT button 
depressed for two seconds. Page the VCD to the right and use the V-Pots to assign a plug-in to the 
channel’s insert point. 

Plug-in parameters are accessible from the console surface by pressing the PLUG-INS button under the 
VFD. Select buttons page through the Slot list. Pressing the right-hand Select button under the VFD 
(SELECT PLUGINS) allows you to page through and adjust the Plug-in parameters.
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VFD (Vacuum Fluorescent Display) Folder Navigation and 
File Management

When you select SAVE AS.., NEW or LOAD (a session) from the Setup buttons on the console surface, or when 
you select LOAD PATCH or SAVE PATCH for any of DSP functions below the VFD, a new set of file management 
submenus appears when you press the Page Right (-->) navigation key next to the display. This gives you the 
opportunity to choose among folders rather than using factory default folder names.

The display looks like this:

================================================

CHANGE FOLDER OPTIONS

Default  Browse    Exit

================================================

Selecting Browse allows you to scan through folder names using the <<  and >> buttons. When the folder 
name you want to use is displayed, press the <-- (Page Left) button and it becomes the active folder.  You can 
create a new folder from the Browse submenu by selecting New. The new folder will be created under the 
appropriate folder.

If you press Default, when working with a patch, the User Presets folder is selected. If you’re working with a 
session, the default folder is Session3.

If you’re editing a plug-in patch or want to load one, you get a different set of folder options when you press 
the Page Right button:

================================================

CHANGE FOLDER OPTIONS

User  Factory  Browse  Exit

================================================

User selects the folder: User Presets\PlugInName, depending on the plug-in with which you’re working.  For 
example:

 \User Presets\MackieFX

Factory selects the folder containing the factory presets, for example:

 \Factory Presets\MackieFX

Browse works as above, allowing you to choose a folder which to load a patch or to save it.

When saving a patch, the current name is displayed along with a cursor at the last character of the name. 
Pressing the Save button again overwrites the original (displayed) patch name with the new settings. If you’ve 
edited the patch and want to save it under a new name, you may edit the patch name using the V-pot and 
<<    >> buttons prior to saving.

Note: The Factory folder is reserved for factory patches. Since you’re not the factory, it won’t let you save a 
patch to that folder.  
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MIDI Map
The MIDI Map window offers setup options for bi-directional MIDI control of practically the entire 
console’s parameter set. The MIDI Map is a complete feature revamp from the V2 Channel List which 
consisted only of channel fader, mute and pan MIDI routing. The V3 MIDI Map provides complete 
parameter access of channel functions, master fader channel strip and Aux master controls, and all 
plug-in parameters. In addition, the Master section and Transport controls are assignable to MIDI mes-
sages. Additionally, a ‘roving’ Fat channel map routing may be added, so that MIDI control may follow 
the Selected fat channel – which is great for external devices such as a joy stick or X-Y pad controlling (for 
example) a channel’s Surround Pan without hard mapping (and subsequent re-mapping). MIDI Maps 
may be created and saved to disk for subsequent recall.

MIDI continuous controller, polyphonic aftertouch, and note on messages are assigned to the various 
parameters via the MIDI Map, in a linear approach of one controller type per parameter. In V2, mapping 
was limited to fader control as continuous controller messages, mutes as note on and off messages, 
and pan as polyphonic aftertouch control messages. In V3, any variable controller may be a continuous 
control message or a poly aftertouch message, and any switch message (on/off or assignment switches) 
can be assigned to a note on (or note off as note on of velocity 0) message. 

In V2, messaging was selectable as In (receive) or Out (send) but not both, whereas in V3 messaging 
may be bi-directional. This means you can control the console from a sequencer or control a sequencer 
from the console. Note that MIDI program changes may also be used to trigger d8b snapshots. Snapshot 
program change messages may occur simultaneously with MIDI Map control messaging. The shorter 
length MIDI program change messages allow for much greater MIDI bandwidth utilization, and in 
some cases can accomplish the required control without totally mapping the console via the MIDI 
Map.Snapshot triggering via MIDI is not enabled in the MIDI Map, but is set via the GUI Setup>Mix 
Options window, by checking the MIDI Snapshot box. 

A listing of D8B console parameters is found in the MIDI Implementation Chart at the end of this docu-
ment. The off, minimum, and maximum values are listed with the associated MIDI controller values to 
aid in setting up a remote control map. Note that many of the console’s values are 8-bit resolution (255 
values). Since MIDI conventionally sends only 128 values (two byte MSB/LSB precision is not supported by 
the d8b), intermediate steps will be interpolated by the D8B.

Applications for the MIDI Map include remote Transport control from MIDI applications that don’t 
support MMC(but do allow their own internal parameter mapping), surround joystick control, or any 
continuous controller or two state switch application (lighting, remote mixing, show controls, etc.). 
Any mapped control information may be transmitted via manual adjustment on the console, snapshot 
recall, and/or automation playback (which may include snapshot or other Event track playback).

Creating a Route
A Route is created by opening the MIDI Map from the Windows menu, then selecting New MIDI Route 
from the MIDI Map File menu or simply clicking the NEW button at the bottom of the MIDI Map screen. 
A Route is made up of the following attributes:

(Selection): The first column (with no column header) denotes the Route number and selected Route 
within the map list. The number is a simple identifier, as there is no sorting mechanism for the MIDI 
Routes. The selection paradigm is the same for any d8b listing function – Shift-click allows for multiple 
selections and Ctrl-click allows for discontiguous selections.

MIDI Status: This choice offers the type of MIDI message (as XNh, where X is the status type, N is the 
MIDI channel, and h denotes that it’s listed in hexadecimal values). If the Route is mapping a switch 
parameter with two value states, it will be assigned as a Note On (9Nh) message. If the parameter is  
continuously variable, the Continuous Controller (BNh) or Polyphonic Aftertouch (ANh) may be used.
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# (number): This assignment is in the range of 0-127 decimal values (00h-7Fh) for the associated Status 
type.

Value: A static value is selectable for a switch message type, in the range of 0-127 decimal values 
(00h-7Fh). It is not selectable and is the implied variable (dynamic, changing, whatever) output when 
using the continuous type status messaging. Note that for d8b controls that use less than 256-step 
resolution, (e.g. EQ type uses 4 values, whereas a fader uses 256 values), the full range of 128 MIDI values 
may not be used.

Route To: This assigns the MIDI route to a console channel strip, master fader or aux send master, master 
section or transport parameter. The actual Parameter within any chosen function is assigned in the 
Parameter column.

Parameter: Available choices follow either the switch or variable control types of categories, as set by 
the MIDI status column selection.

Value: A value is displayed when the Route is a switch type. The displayed value typically will be either 
On or Off, but may show some other type of descriptor such as ‘Pre’ or ‘Post’ as an aid to determining 
the Status function.

Direction: The MIDI Route is set to Receive, Send or Both. Take care to avoid MIDI feedback.

The File menu inside of the map contains the following additional commands:

Open MIDI Map: recalls a saved MIDI Map from disk. If a map is currently in place, it will be entirely 
overwritten by the map from disk upon loading.

Save MIDI Map As...: saves the current MIDI map to disk as a Map file, which is available for recall at 
a later date.

MIDI Channel: sets the global MIDI channel for the entire map. 

Delete MIDI Route: deletes the currently selected Route(s) within the list. The DELETE button at the 
bottom of the MIDI Map window does the same. Multiple Routes may be selected using the Shift-Select 
or Control-Select keyboard combinations.

MDS Network

The MDS Network (that’s Mackie Digital Systems, in case you were wondering) is an improvement over 
the d8b V2’s method for interconnecting two consoles.  In V3, rather than just linking two consoles, 
any number of consoles can be linked through their Ethernet ports, on eight independently addressed 
control busses. A console assigned to MDS Bus 1 can talk to other consoles similarly assigned, but will be 
ignored by consoles assigned to other control busses.  On a single network (a group of consoles assigned 
to the same MDS bus), each console is given a unique name – that’s how they know who’s who.

It’s important to understand what the MDS Network is, and is not.  It’s not a means to remotely control 
the mix on another console – the consoles, including their automation, operate independently. If you 
have another 48 channels coming into your mix on a second d8b, you still have to mix those channels 
using the controls on the second console. What the MDS accomplishes is to tie switching functions 
together between the networked consoles. These are primarily controls over in the Master section of 
the console. 
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The Link Options check boxes in the MDS Network setup window are filters.  When a function is 
checked, the console will both send and receive link information for that function. When the box is 
not checked, the console will ignore switching commands sent by another console, and will not send 
those commands. 

The Link Options are described as follows:

Fader Banks Links the fader bank switching (Mic/Line, Tape, Effects, Masters)  

Aux Strip Switches the channel strip V-Pot assignment on the remote console  

Bus Assign Switches the ASSIGNMENT switch group on the remote console 

Cue Controls Switches the source and level of the Cue/Phones mix on the remote console 

Solo Logic Switches the Solo mode (PFL, AFL, Master) on the remote console 

Speakers Switches the Control Room speaker source and destination (Main, Near Field) as well as 
 adjusts the volume on the remote console. This is the only non-switching function sent  
 over the MDS network. 

Sample Rate Switches the sample rate on the remote console. (word clock must be interconnected) 

Automation Switches the functions in the Automation group (Bypass, Faders Off, etc.) on the remote 
 console. 

Load/Save Duplicates Save and Load functions on the remote console. When Loading, or Saving-As, 
 the file name must be entered on both consoles. 

As an example, with Fader Banks linked, when switching fader banks on one console, other consoles 
on the same bus will follow suit – so when working on the mix on the second console, you’re already 
switched to the proper fader bank. If Solo Logic is linked, when you solo a channel on one console, 
channels on the other console are muted. 
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Standard networking technology is used to interconnect two consoles. If you’re not going through a 
hub, you’ll need a crossover Ethernet cable between peer to peer connections. All that’s required is to 
interconnect the two consoles and set them to the same Network channel. If the audio is interconnected 
digitally, the word clock on both consoles must be from the same source, or one console’s clock input 
must be synchronized to the other’s clock output.

Generally the audio between consoles is linked through Alt I/O cards. The sources for Alt I/O outputs 
can conveniently be assigned from this setup window. Typically they’d be assigned to the eight busses, 
the L/R main bus, or the twelve auxiliary send busses. In working on a large surround mix, for example, 
you might want to bring the busses to which you’ve assigned the surround outputs on the secondary 
console over to the main console for mixdown.  Although much of the audio routing is previously 
explained in the v2 Owner’s manual addendum, the following may help the cascading D8B user:

For Stereo, Quad, LCRS and 5.1 Surround applications: assign busses 1-6 (as applicable) via the ALT I/O 
configuration in the Setup / MDS window and the L/R Mix using the ALT I/O 7th and 8th bus slots as 
separate Mix L and Mix R busses. This is true 24 bit because ALT I/O has been updated as such in v3.0. 
Free busses can be used as Aux send cascades for external effects sends.

7.1  Send busses 1-8 over the ALT I/O.  You probably aren’t going to be using the L/R bus but if really 
you need to, use the stereo digital in (like the check box used to work...) and route the Digital in L and 
R to 2 empty channels on the Pre Insert on the Master Console. Sum the D8B in at unity and avoid 
attenuation in multiple places.  Use the master fader on the sub-mixer the signal came from. Note that 
the 2 track in is 20 bit and not 24 bit - hence if true 24 bit slave to master connection is desired, then 
use the ALT I/O crossover.

The cleanest signal path and recommended way for the cascaded D8B L/R Mix is to use the AltIO card 
with the Returns set to Unity Gain.

Also note the stereo Solo busses are not cascade-able busses, hence Mixdown solo applies for the 
cascading digitally, but note that if you route the Mains of the submixer out to two channels of the Main 
mixer, you’ll also need to solo isolate these two channels so that they aren’t implicitly muted during a 
solo operation on other channels on either of the cascaded consoles.

Automation

An Important Upgrade Note!!
V3 has no Import function for snapshots placed in a V2 dynamic automation track. If you recorded 
Snapshot events into a dynamic automation track in V2 and want to use these snapshot files in V3, it 
is necessary, using V2, to make note of the snapshots used and the exact times during the mix that 
these snapshots occur within the automation track (available using the Snapshot filter to view only 
the snapshot occurrences in the V2 Event List). When the mix is loaded in V3, it will be necessary to 
create new Snapshot events in the Event Track, and set their times to match the recall times as in the 
V2 mix snapshot track. 

Just a quick mention also that if you had mixed snapshots and dynamic automation in the 2.03 files 
- where snapshot positions of any given parameter were captured when a track was subsequently 
‘flattened’ into dynamic events because of a dynamic overwrite and released from snapshot recall - 
this automation track crossover would already be released from Snapshot recall of that parameter and 
would transfer just fine into v3.0.
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Snapshot Filter 
The Snapshot window contains  an additional field entitled  “Filtered” The Filter is a new and powerful 
function, allowing certain console functions to remain unchanged when the snapshot is recalled - either 
directly or via automation using the Event Track.

Double-Clicking on the Filtered field in the Snapshot window brings up the Snapshot Filter window 
with check boxes for the following functions: Fader position, EQ setting, Phase (polarity), Mute Status, 
Compressor settings, Plug-in patching and settings, Pan, Gate settings, Direct routing, Aux assignment, 
and Bus routing. 

Filtering does not change what’s stored with the snapshot – the complete console layout is still always 
stored. These are playback-only filters and can be switched on and off at will while you experiment with 
your mix.  For example, if a snapshot is taken with a channel muted, with MUTE checked in the Filter 
window, recalling the snapshot will not mute the channel if it is presently unmuted. 

Applications like using a snapshot for EQ ONLY,  or all but EQ,  globally, makes this a pretty powerful 
feature.

Snapshot Folder 

It is now possible to save and recall snapshots to disk, to be used across sessions as rough mix templates 
or starting setups. Save and recall your snapshots using the Open Snapshot and Save Selection As... 
functions  from the Snapshot window’s Edit pulldown menu.

Note that when saving snapshots to a folder on disk (using the Snapshot window Edit>Save Selection As 
operation, the snapshot file name within the folder directory is not carried over or back as the snapshot 
name listed in the Snapshot Window. If you’ve named the snapshot by editing the Name field in the 
Snapshot window, that name will be saved with the snapshot file and will appear in the Snapshot 
window when you Open that snapshot. Good housekeeping will help you here.

Event Track
The Event List has been replaced by the Event Track, which allows for a new approach of time stamping 
snapshot recall (see Snapshot filter) and modular DSP recall from disk of EQ, Gate, Compressor and 
Snapshot-type patches. 

The Event Track window is accessed via the Windows Menu. It offers the ability to recall snapshots 
and any channel or plug-in DSP patch file stored on disk during automation playback. This feature 
replaces the Event List of V2, allowing easy access to automation data via the Mix Editor. The dynamic 
Snapshot Automation track is no longer available within the Mix Editor, however Snapshots may now 
be automated using the Event Track. 

(note: if you skipped ahead to Event Track and didn’t read the warning about automated snapshot 
reproducibility using v2.03 files, please read backwards to the beginning of the Automation section).

The Event Track Data Fields
The line contains, from left to right,: a time/playback indicator arrow, an automation playback (Mute) 
defeat icon, the Event type icon, the Action, the playback Time, the directory path (‘Info’), and a user 
modifiable description text field:

Playback arrow: Displays a pointer relative to the current time within the playback list

Playback defeat: If toggled on, will defeat the event from playback. The defeat state is not saved with 
the session - it is for temporary playback use and can also be used to compare the action of two similar 
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events occurring at the same time.

Event type icon: Matches the icons found in the file directories - used for a quick ID

Action: Describes the basic function - either a recall or file load

Time: Time of recall - double clicking on this field allows for editing the values. Use the Enter key or 
click elsewhere to exit the time editing operation. Upon exiting, the events are rearranged in a temporal 
order.

Info: This is the directory path with which this function references and recalls files from disk. Double 
clicking on this box will re-open the dialog for modification of the path or to chose another file, etc. 
Exiting the dialog is accomplished using Save or Cancel operations.

Description: A handy text box, for notes regarding the Events

Using the Event Track

New Event:
Creates an Event line entry for automation recall of snapshots or loading of any channel (entire channel, 
EQ, Gate or Compressor) or plug-in DSP preset file. A dialog box pops up to select the Event Type the 
time when the Event will be recalled. Time defaults to the console’s current Locator time. The Type choice 
dictates the context of the lower half of the dialog window.

If the Event Type is Snapshot, the Snapshot number is entered via an Edit box. This references any 
snapshot, whether it exists or not. Usually you’d create the snapshot first and then call it in the Event 
Track, but you can use the Snapshot number as a placeholder in the even track as long as you eventually 
create the snapshot that you want in that place. If the snapshot doesn’t exist, the Event Track won’t 
complain, but no changes will be made to the mix during automation playback. 

If the Event Type is an entire channel setup, the target channel is selected using the ‘Load target’ 
popdown menu. The Path to ‘browse’ for the channel patch file is available via the Browse button, and 
after the file selection is completed, the file and its path is listed. 

Normally, a channel is saved to disk using the Channel Menu ‘Save Channel As...’ function, after which it 
is available via the directory path Browse button in the Event Track dialog box. If a patch is modified or 
removed, the Synchronize Events operation will tell you what’s missing and help you find it.

The process is similar for other Event Types. EQ, Compressor and Gate events are saved using the Save As 
function under the MENU button in that processor’s section of the Fat Channel GUI. Plug-In events are 
saved using the Save As function under the plug-in’s MENU button. 

Duplicate Event:
Duplicates the selected Event line, for subsequent editing. This function only will duplicate one event 
at a time.

Capture Event Time:
Copies the current transport locator time into the Event’s time. When listening to playback, this is a 
handy way to plant an event “by ear”.

Run Event:
Triggers the event playback without the need for automation playback. This can be used to resurrect a 
modified patch to be saved to disk or to A/B against a current setting by using Memory A and B.
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Synchronize Events:
Synchronize Events is used to match file data from the current opened session with the DSP patch files 
(EQ, Comp, Gate, Channel, Plugin) on disk that are referenced by the Session’s Event Automation Track. 
In short, it is a ‘Disk to RAM’ correlation. 

There are many reasons the various DSP files that the Event track references may need to be resynchro-
nized - files get re-named, deleted, updated or moved. An important thing to keep in mind is that a 
session saves all of the Event Automation Track parameters regardless of whether or not the original 
referenced DSP files exist. This ‘safety net of reproducibility’ is an important design issue. It assures that 
no instructions on what to do in an automated mix will be lost even though the tools to perform those 
instructions (the DSP files) may not be available at the time. 

When a session using Events is loaded, the OS performs a match against the dependent files, and 
displays any detected mismatches by adding an asterisk to the ‘Action:’ column of the Event line where 
data necessary to perform that event can not be found on the specified path. This identifies events that 
require Synchronization before they will be executed properly. 

Event lines must be highlighted first before performing a sync operation. The following discussion will 
cover various ways in which files may be subject to Synchronization operations: 

Example: Altered file on disk - If an Event is to load a patch called EQ#2 at time 00:07:15:00 and the OS 
detects that the ‘EQ#2’ patch on disk has different parameters than what the Event expects, the Event 
Automation Track displays the Action: as ‘Load EQ *. To match the session’s Event to the patch file on 
disk, select the Event line by clicking anywhere on the line, then select Synchronize Events from the Event 
Track Edit menu. Synchronizing will overwrite the session’s patch information with the disk’s patch - 
not vice versa. What’s on disk is what will be called by the Event Track. If that’s not what you want, 
reload (you did back it up, didn’t you?) or re-create the desired EQ and edit the Event to call your desired 
EQ settings.

Example: Altered File during a session - If you modify a channel DSP parameter while the current session 
is open, then attempt to save it under the name of a setting that’s called by the session’s Event Track, the 
Event Synchronization function will immediately call your attention to this by inviting you to change 
the Event Track’s data to match your new EQ setting. If you respond with Yes, the session Event will 
update to match the patch as you’ve just saved it. If you respond with No, when you next open the 
session, you’ll find the patch marked with an asterisk, and you’ll need to synchronize. 

Example: Missing file – If an Event is calls for a patch called EQ#2 to be loaded at 00:07:15:00 and the 
EQ#2 file no longer exists in its original folder path, the Event Automation Track will display the Action: 
as ‘Load EQ *. 

Re-synchronizing the event will not drop the asterisk, because the session will never be able to find 
the missing file. You can play through the event with the missing file and it will simply be ignored. 
Alternately, you can edit the Event to call an existing EQ patch file, or you can re-create the EQ settings 
you want at that Event time and save the patch under then name called by the Event Track. Once the 
file exists, re-synchronize. 

Example: Missing Plug-in: If an Event calls for loading a plug-in patch namee Delay#2 at 00:12:15:00 and 
the Delay Plug-in has been unassigned, reassigned, not loaded, or the card sold to the highest bidder, the 
Event Automation Track will display the Action as: ‘Load Plugin *. 

Re-synchronizing the Plug-in Event will not drop the asterisk until the Plug-in is reassigned to the 
exact slot location where it existed when the Event was created. Reload the Plug-in to the specific slot, 
resynchronize the event line, and the asterisk will be dropped.

Note: Synchronize Events does not act upon snapshots, because it does not directly reference snapshots 
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from disk. Any changes to snapshots within a session operation will not be displayed as modified Event 
lines, in the same manner as DSP patch file references.

Delete Event:
Deletes selected Events from the Event Track. Multiple events can be selected using the Shift-click or 
Ctrl-click. Deleting an event from the Event Track doesn’t delete the patch data that the Event calls, but 
the Delete operation in the Event Track is not saved in the console’s history list, and therefore cannot 
be undone. 

Select All:
Selects all events within the Event Track Window.

Clear Automation
This function, accessed from the pulldown Edit menu, allows deletion of automation events by category 
on selected channels. 

Since other features in V3 have superceded the old Event List, this function provides the means to clear 
automation control on selected channels without going to the Mix Editor. 

Selecting Clear Automation from the Edit menu brings up a dialog box with check boxes for the various 
event types which can be cleared, including removing all automation events from the channel. The 
action takes place only on SELECTed channels, one at a time, or on multiple selections. 

Note: Plug-ins aren’t included in this dialog. Removing the plug-in from its slot, either by assigning the 
card slot to None or to a different Plug-in, clears plug-in automation.

Mix Editor 
The Mix Editor received a facelift in V3, borrowing several features and graphics from the HDR24/96 
Hard Disk Recorder. 

• Zoom arrows expand and contract the screen, scaling horizontally in time, and vertically in the 
number of tracks displayed. A fold-up/fold-down arrow exists at the bottom of the parameter 
column, for use in collapsing and expanding the vertical size of the Mix Editor window.

• To allow you to keep your eyes focused on the work area, you can now switch tools by right-clicking 
in the track area and selecting from a pop-up menu.

• When the Hand tool is active, holding the Ctrl key temporarily turns it into an eraser.

• Right-clicking in the Time Bar above the track screen pops up a menu for selecting snapping and grid 
options, looping, and selecting the Time Units displayed (SMPTE, BBT, or HMS+milliseconds

• Clicking on a node in an automation track pops up a window showing the time and value at that 
point.

• An available automation event counter number is displayed under the Autofollow button in the 
upper right corner of the Mix Editor. The readout indicates how many nodes are left in the gas tank. 
If you use all of the nodes, you have created one heck of a mix.
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Parameter tracks have been updated to match the new Plug-in capabilities

The familiar “one parameter for all channels” view is still there, but clicking the CHANNEL VIEW button 
brings up a new set of buttons (replacing the cool Mackie Running Man) which allow you to select 
parameters to view for a single channel. For example, you can view all of the EQ parameters for a single 
channel, each on its own track. This makes for less screen clutter.  

A new page-oriented auto-scroll mode scrolls the time bar from left to right across the screen, then 
jumps to the next page when the time bar reaches the right-hand edge.

History List and Multiple Undo/Redo Operations

The History List, found under the Windows menu, is a linear, mul-
tiple undo/redo function that is used with Mix Editor, clipboard 
(Cut, Paste) and automation pass operations (Automation Record 
pass). 

The simplest way to understand History list operation is to open 
both the History List window and the Mix Editor window side 
by side and start adding and deleting automation nodes in the 
parameter tracks of the Mix Editor. There is an entry created in the 
History List for each edit. 

Note: Selecting multiple events in the Mix Editor and cutting or 
pasting them creates one entry in the History List. 

After the History List has recorded several actions, click somewhere 
up the list from the bottom and you’ll see that actions are undone. 
You’ve been taken back in time, editing wise. Check out clipboard 
and automation record pass operations with the history list open 
and the Mix Editor within view. The operation will become appar-
ent.

The linear aspect of the History List dictates that once you’ve 
undone any number of actions and resume once again with edits, 
all of the actions past the point you restarted are gone forever. If 

you’re ever unsure about undoing automation moves, then restarting at any point, save the session 
beforehand and go forth. It’s that easy.

The VFD also reflects the multiple undo/redo capability. The Clipboard section Undo works bi-direction-
ally with the History List for clipboard and automation record pass operations. Press Undo and the VFD 
will offer the number of actions (200 max limit), Undo, Redo and the ability to exit out of the Undo 
function. The default Undo action (multiple presses on the Undo button) is to keep undoing. Exit is the 
one way out, baby.

Techniques for Automating Plug-ins

Dynamic Real-time Plug-in Automation
To write automation on a loaded plug-in, from either AUTOMATION section of the console work surface 
or the Automation submenu from the Options pulldown menu:

• Engage Auto Touch

• Engage All 
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• Disengage Automation Bypass

• Send Time code to the console - the Position readout will change to show TC is being received

Parameter changes will be recorded in the Automation file. If you which to simply recall a patch, either 
a factory preset or one you’ve created, it’s best to do that using the Event Track rather than to write it 
as part of dynamic automation.

Subsequent edits to any recorded automation moves may be performed in the Mix Editor.

Plug-in Automation Using the Mix Editor
• If it’s not already loaded, load the plug-in you want to automate.

• Open the Mix Editor Window to view plug-in automation tracks

• Press the Channel View button.

• Select the plug-in you want to edit from the PAGE popup menu. The parameters the plug-in requires 
when the specific algorithm was loaded will be displayed as tracks.  

• Select the Hand tool and add a node by clicking in one of the parameter tracks. Drag the node to 
the desired parameter value.

If Auto Follow in the Mix Editor is turned on, the knob you are twisting will automatically highlight its 
parameter track and display the input data dynamically when the console is receiving time code.

Once a parameter is automated and the automation bypass is disabled (so it’s On), that parameter 
will always CHASE automation and ignore patch changes. To restore its patch change awareness, 
double click its track and select “CUT” to remove automation moves.

Dynamic Offline Plug-in Automation (Event Track)
Use the Event Track to load plug-in user (previously stored) or factory-preset patches, at a specific time 
during automation playback.

Note that plug-in settings are recalled as part of a console Snapshot, but may also be recalled as Presets 
(patches). If you are recalling snapshots and presets, be aware that one may override the other.

User Interface (Appearance)

The Big Picture in V3. 
Clicking on the FADERS button at the bottom of the GUI screen toggles between the conventional 
full channel strip view of 24 channels and an abbreviated 48-channel fader/V-Pot view. In this view, 
Channels 25-48 are displayed in the top half of the mixer screen, while the faders in the bottom half of 
the screen follow the bank selection switches. This gives you an on-screen view of your tape mix plus an 
additional 24 channels – effects, busses, or even returns from the Line inputs.

Clicking on the PANNING button at the bottom of the GUI screen brings up a bird’s eye view of the pan 
settings of all 48 channels, plus effects and returns channels. Surround panning can be done from this 
screen. Right-clicking on a channel in this view brings up a handy menu to undo or reset the panning 
on that channel, copy the pan settings to the clipboard, paste them into a channel, or undo the last 
pan change.  

Hot Keys (Keyboard Shortcuts)
The latest keyboard shortcut keys are listed in a pulldown window under the Windows menu. Check 
‘em out.
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Housekeeping
Here are some new features for file and session management.

Desktop
The Desktop is a graphical file management tool. Open the Desktop either by clicking on the Desktop 
button on the bottom of the main mixer screen or selecting Desktop from the File menu. The desktop 
screen displays icons for the floppy and hard drives as well as the toilet icon for disposing of files and 
folders no longer needed. 

Click on either disk icon to open a window displaying the files and folders contained on that disk. Click 
on a folder to open another window displaying the folder’s contents. 

Clicking on the drive icon again opens an additional window for displaying other folders or files. Files or 
folders can be dragged between the floppy and hard drives, or between windows. Multiple files can be 
copied or moved using standard Windows multiple file selection conventions of Shift-Click or Ctrl-Click. 

Desktop file management is not yet fully drag-and-drop in that you can’t plop a file straight on to a 
folder, you must open a window for that folder first. 

The pull-down Edit menu allows you to create new folders, rename files or folders, and cut, copy, or paste 
between windows. Pulling the Edit menu down from a window works within that window, pulling it 
down from the top level menu works on the active window.

Template and the Startup File
The Startup session file is no longer the “template” for new sessions as it was in V2. In V3, the Template 
is maintained separately and can be updated at any time by pulling down the File menu and selecting 
Save As Template.

The following information is stored in the Template:

Channel Name

Noise Filter setting

Cross-patched channel assignments

Bus cascade assignment

Stereo/Surround setting

Current Tempo (default to 120bpm)

Time Code Display Units (SMPTE/BBT/Milliseconds)

Mix Editor - 

Grid Setting (resolution - called Snap Grid in the popdown)

Enable Snapping

Snap to Cues

Snap to Grid

Many other functions carry over from session to session when opening a new session, but are not part 
of the Template. Sample rate is one example.

The Startup session file is now just like any other file. It is automatically created if there are no other 
sessions on disk, but it’s not referenced at any other time. If you want to have a known set of starting 
conditions for a new mix session, you can do one of the following:
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• Create a snapshot of your favorite settings, save it to disk, and subsequently import it into the new 
session.

• When the basic session is set up, save the session, always start a new session with that file, and 
immediately Save As another name. You would probably have a primary snapshot at the top of this 
file to reset everything with. 

Miscellaneous Improvements:

Fader operation - fader response for linked channel and automation activities has been tweaked. You’ll 
immediately notice the difference when you’ve linked faders, that they no longer fight you when grab-
bing both at one time. 

Also, during automation writing, when the automation fader track data is not sloped in either a fade in 
or fade out manner, faders may be adjusted in a similar fashion to if the Channel List Playback function 
was set to Punch-Run. In other words, you can change levels without the fader holding fast by tracking 
the previous automation move. But as always, the fader will return to it’s previous position on any 
transport locate or time code recall, if automation is not bypassed. We still suggest that if you want 
to tweak the fader and automation is controlling it, use the Automation global Bypass, or channel 
Punch-Run or Disable Playback function.

A Default MIDI Tempo may be set for the BBT readout, via the Setup Window under Locator-MMC 
options. Loading a Standard MIDI File will overwrite the current tempo, and the tempo readout will be 
updated as the SMF tempo map is read during playback.

Milliseconds time resolution view is available: Right click on the Locator Time Code readout and switch 
to Milliseconds if desired. Clocking accuracy and BBT resolution has been improved as a byproduct of 
HDR24/96 development.

Locator: Cue List Implementation from the keyboard has borrowed a few tricks from our HDR24/96 
feature set...the right keyboard number pad side now allows for the following:

1. +/- navigates the cue list, forward and backwards through the cues

2. Ctrl + M captures a cue at the current locator time

3. Specific Cues are recalled by first entering numbers and then engaged by pressing the Enter key. The 
last cue called is buffered so that it may be repeatedly recalled by pressing Enter.  e.g. type ‘1’, then 
‘2’, then ‘Enter’ and cue 12 will be recalled. Press Enter again and cue 12 will be recalled again which 
is especially handy if you’re rolling time code and simply want to return to the last locate without 
typing the whole cue entry in.

4. Cue list times are editable - double click on the time fields and enter by typing in the update values, 
or clicking and dragging on the numbers to change the current value. Pressing Enter or clicking 
elsewhere will complete the entry update.

5. Looping is more flexible via the Mix Editor. If Loop is engaged on the control surface, between two 
cues, Loop icons (L) will appear on the Mix Editor time bar. These Loops Start and End times will 
match the current cue times to start, but may be dragged about while time code is running, to hone 
in on specific audio endpoints.
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Say bye, bye...

The Fade Curve feature has been removed. The Mix Editor has superceded the need for this legacy 
feature. 

The OS doesn’t allow for magnification of plug-in windows as it did with the MFX EFX in  V2. We suggest 
sitting closer to the screen and/or buying a bigger screen. Or wear bifocals.
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MIDI Implementation Chart
Mackie Designs Model: Digital 8-Bus Console  
Version: 3.0 
Date: December 2000

Function  Transmitted Recognized Remarks 

Basic Channel Default 00 00 See manual for MIDI Map  
 Changed 00 – 0F 00 – 0F information

Mode Default Poly Poly Exception: Program changes are 
 Messages   Omni
 Altered
    
Note Number True Voice 00 – 7F 00 – 7F
  
Velocity Note On Switch On = 01 Switch On = 01 Note off (8nh) not supported
 Note Off Switch Off = 00 Switch Off = 00
  
Aftertouch Key’s Channel 00 – 7F 00 – 7F 
 
Pitch Bend  X 0 Vocal Studio: Channels 0, 4, 8, C  
    (hex)
    MFX: MIDI channel is equal to
     the assigned slot number 
    (decimal) 

Control Change  00 – 7F 00 – 7F 
 
Program Change True Number 00 – 7F 00 – 7F Receive Omni
 
System Exclusive  X X
  
System Common Song Position X X
 Song Select X X 
 Tune Request X X
  
System Realtime Clock Commands MMC MTC D/e frame
  
Aux Messages Local On/Off X X
 All Notes Off X X
 Active Sense X X
 System Reset X X
  
Notes  1.  MMC open loop commands: STOP, PLAY (03), FF, REW, REC (06),  TRACK  
      ARM (41), LOCATE, SHUTTLE, STEP (JOG)
  2.  MMC Device ID’s (0-5)
  3.  All values listed in hexadecimal
 
Mode 1: Omni On, Poly Mode 2: Omni On, Mono O: Yes
Mode 3: Omni Off, Poly Mode 4: Omni Off, Mono X: No


